


4D BOXING™

PLEASE !
PAY TO PLAY, OR EVERYONE GETS TKO'D

Developers of computer simulations use the money they make from the sale of
their products to stay in business. If potential customers steal their poods and
services, prices must be raised to compensate for the losses. Soon legitimate
customers can't afford to pay the higher prices, and everyone loses.

4D Boxing was produced for your enjoyment through the combined efforts of a
dedicated team at Electronic Arts. We—designers, artists, programmers, and
other committed professionals—depend on you to pay a fair price for our
software so we can afford to create and develop new and better games. We
encourage you to play and enjoy 4D Boxing with your friends, but please don’t
make illegal copies of the program for them.

As a member of the Software Publishers Association (SPA), Electronic Arts
supports the industry’s effort to fight against the illegal copying of personal
computer software, Thank you for helping us in our effort to control software
costs by eliminating software theft. And please remember, copying computer
software for any other reason than to make a backup is a violation of federal
law. Individuals who make illegal copies of this software are subject to civil and
criminal penalties,
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INTRODUCTION

TRU-MOTION™

Fed up with the choppy motion and poor punch selection of conventional
boxing simulations, we set out to design a game that would truly replicate the
movements of real boxers. What emerged was Tru-Motion, the most fluid, life-
like boxing action ever brought to the computer.

The heart of Tru-Motion is human movement. A human boxer was videotaped
tor hours, performing a full range of punches and blocks. We analyzed these
lapes for weeks, capturing every subtle move. This led 1o the creanon of
figures that punched, ducked, and moved hke real humans.

Polygon graphics were added to provide the fast, fluid motion you“ll
experience in 4D BOXING. Rather than redrawing every change on the
screen, we 've superimposed solid polygons on top of “hangman™ figures 1o
give them a more human appearance. We call the final product Tru-Motion,
because that's what we think it is—the truest, most realistic boxing acton ever.
Welcome to the next generation of sports games—with Tru-Motion.

THE BOXING GAME

4D Boxing captures all the combative action and compenitive challenge of big
time boxing. You'll create your own stable of fighters, customize their umique
skills and physical characteristics, and train them at your gym.

When a boxer is in peak condition, launch him on a professional career.
Perhaps he'll make it to the Main Event Championship match and end up
enshrined in the Hall of Fame! But if he tums out to have a glass jaw or a
paper punch, don’t worry. Simply create a new prospect and try again.

4D Boxing offers you all the lip-splitting excitement and thrills of world class
boxing, without bruised ribs, cauliflower ears, cigar smoke in your eyes, or
blood on the canvas. If you're ready, the bell’s about to nng.



GETTING STARTED

INSTALLING 4D BOXING

To play 4D Boxing, you'll need a Macintosh computer with at least 1IMB of
RAM. 4D Boxing comes on two disks, a Program Disk, and a Data Disk. You
need to copy these disks to your hard drive or to blank floppies to play the
game.

NOTE: An RGB-color monitor is NOT required, but will increase your
enjoyment of the game. If you want to play in color, you MUST install the
program to your hard drive. You'll need at least two megabytes of memory
to play the color version of the program and the Monitors setting in the
Control Panel should be set at 256 colors.

If you only have one megabyte of memory, you can only play in black and
white. To play in black and white, open the Control Panel and change your
Monitors setting to “2 Colors, Black & White/Grays.” If you don’t change
the Monitors setting while playing in monochrome, problems will occur.

Hard Drive Users

To copy 4D Boxing onto your hard drive:
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Turn on your hard drive and computer.

Open the hard drive window (if it isn’t open already).
Press 3 N io create a new folder. Name the new folder “4D Boxing.”
Insert your original 4D Boxing Program Disk into the drive.
Double-click on the 4D Boxing disk icon to open the disk window.
Press ¥ A 1o select all of the files on the Program Disk.
Place the mouse cursor on one of the files. Press and hold
down the mouse button and drag the files over to the new
4D Boxing folder; release the mouse button.

Repeat steps 4 through 6 with the Data Disk.

When your computer is done copying, store your original
4D Boxing disks in a safe place.




To Start the Game
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Double-click on the 4D Boxing folder to open the folder window.
Double-click on the 4D Boxing icon. Click the mouse to bypass the
splash screen. The Main Menu appears.

Hard Drive users can move to page 6, the MAIN MENU.

Floppy Disk Users—Copy Your Disks

Before you begin, MAKE A COPY OF THE ORIGINAL DISKS. Make copies
now and put the originals away in a safe place. Be sure your original 4D
Boxing disk is locked prior to copying it (set the tab to “open”). If you're
going to play from floppies, you'll need two blank, formatted disks. When
your computer is done copying, store your original disks in a safe place.

One-Drive Systems

i i e

Boot vour Macintosh with System 6.0.5 or greater.

Format a blank floppy disk . Press % E eject the disk.

Insert your original 4D Boxing Program Disk into the drive.

Double-click on the disk icon to open the disk window.

Press ® A to select all of the files. Place the mouse cursor on one of files.
Press and hold down the mouse button and drag the files up to the blank
disk icon; release the mouse button.

NOTE: When naming the new disk, be sure to use the same EXACT
letters and number of spaces as in the original disk name.

6. The computer will prompt you when to insert the original disk, the copy
disk, or your Svystem disk.

7. Repeat steps 2 through 6 to copy 4D Boxing Data Disk.

Two Drive Systems

1. Boot your Macintosh with System 6.0.5 or greater.

2. Format a blank floppy disk.

3. Insert your original 4D Boxing Program Disk into your other dnve.

4. Double-click on the 4D Boxing disk icon to open the disk window.



5. Press ® A 1o select all of the files in the 4D Boxing Program Disk.
Place the mouse cursor on one of the files. Press and hold down the mouse
button and drag the files up to the blank disk icon; release the mouse
button.

6. The computer will prompt you when to insert the original, the backup, or
your System disk.

7.  Repeat steps 2 through 6 to copy 4D Boxing Data Disk.

To play 4D Boxing

I. Insert your Copy of the Program Disk into the drive. Double-click on the
disk icon to open the disk window.

2. Scroll until you see the 4D Boxing icon. Double-click on the icon. Click
the mouse to bypass the splash screen and credits.

3. You'll be prompted when to insert your copy of the 41 Boxing Data Dask.

SE Systems—Playing from Floppies
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Boot your Macintosh with System 6.0.5 or greater.

Insert your copy of the “4D Boxing Data Disk” in the floppy drive. When
the disk icon appears, select Eject from the File menu.

Insert your copy of the “4D Boxing Program Disk”.

Double click on the disk icon, then double click on the *4D Boxing™ icon
to start the game.

Follow the onscreen instructions, swapping disks as requested.
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Figure | Main Menu

You can choose any selection in the Main Menu immediately: fight in EXHI-
BITION or MAIN EVENTS bouts, go to THE GYM to create fighters, set
your game OPTIONS, start the self-running DEMO, or EXIT the program.

A good fight trainer would recommend that you select OPTIONS the first time
yvou reach the Main Menu. From here you can set your fighting interface, and
other game options. After that you can go to The Gym to view and create
boxers, and then enter Exhibition and Main Event fights.

But if you just can’t wait to see vour first fight, select EXHIBITION (see
EXHIBITION, below), pick vour fighter and an opponent, then go to the arena and
try for the knockout. Before the bell sounds, be sure to refer to the table of
controls for punching, blocking, movement and showboating. See BOXING
CONTROLS., below,



OPTIONS

To access the game-play options, use the mouse to click the OPTIONS icon.
Click the mouse to display the Options Menu.

Figure 2 Options Menu

If you are playing 4D Boxing on a black and white Macintosh, the Blue boxer
will be referred to as the Gray boxer and the Red boxer will be the Whate

boxer.

The top row of icons affects the Blue Boxer, the boxer that will fight from the
blue corner. The second row affects the Red Boxer.

The icons represent from left to right: the main keyboard, numenc keypad. and
a computer controlled opponent. Most menu operations in 4D Boxing are point
and click. Point at an icon or menu option, and click to select it.

BOXER INTERFACES

When you first start 4D Boxing, it's set to fight in one-player
mode. You control the Blue Boxer with the numeric keypad,
and the computer controls the Red Boxer. Other boxer control

combinations are possible.




Two human opponents can fight Exhibition bouts using the main keyboard and
numeric keyvpad. Exhibition bouts can also be fought by a human opponent
against a compuier opponent or with two computer opponents.

Select one-player, two-player or computer control mode by selecting the
appropriate icons and pressing Return. Only the Human controlled Blue Boxer
can fight in the Main Event, so when you enter a boxer in a Main Event fight
your opponent will always be controlled by the computer. Even if you've been
fighting as the Red Boxer in Exhibition, you will automatically become the
Blue Boxer for the Main Event.

BOXER AND FIGHT OPTIONS

Selecting Boxer Measurements

The Height and Weight information for all boxers is automatically displayed in
LS. customary measurements. By selecting the Lbs icon from the Options
Menu you can toggle the measurements to metric. The icon will then be
displayed as Kg and all measurements will be displayed in metric throughout

the program.

Selecting Rounds and Round Length

All amateur and professional boxing matches use 3 minute rounds, but 4D
Boxing allows you to set your own lengths for Exhibition matches. Fights of 3
to 15 rounds are possible, with round lengths of 1 to 3 minutes. Click the the
Rounds and Length icons to cycle through the options.

Main Event fights automatically start with 3, three minute rounds, then
increase (o 4, 5, 6 all the way up to 15 rounds.

The SimHigh/SimLow button allows Boxing 1o run faster on machines with
‘t( limited processor speed. SimHigh sets the program to include all intermediate

boxer movements that are not controlled by the plaver. When set 1o SimLow,
the boxers will not bob or move as much. For more information, see Adjusting
Crraphics and Animarion under the CONTROLS section. Select the VER button to
see the version number of 4D Boxing.



All selections from the bottom row of the Options Menu are saved to disk for
future use. If, for example, you set a fight to go five 2-minute rounds, the
program will remember this the next time you play. Any time you wish to
shorten or lengthen the next fight, simply retumn to the Options Menu and
adjust the Length.

When you're finished making selections in the Options Menu, click on Done
or press Retum to retum to the Main Menu.,

EXHIBITION

If vou're in the mood to just duke it out with a friend or against the computer,
this is the place for you. Exhibition fights are fought for fun and pride only,
with nothing else riding on whether you win or lose. Since they 're not profes-
sional fights, your boxer's win/loss record is not a consideration. If at the end
of a fight you turn out to be the loser, you can pretend the loss never happened.
If vou decide during the course of a fight that you or your opponent are over-
matched, you can throw in the towel 10 end it.

Select OPTIONS before your Exhibition fight to choose one or two player
maode and yvour preferred boxing interface (keyboard or numeric keypad).

CHOOSING BOXERS

When you select EXHIBITION, the screen shows a gym where the boxers are
training. The boxers are always identified as HUMAN or COMPUTER
controlled. Whether controlled by a Human or the Computer, the Blue Boxer
on the left will always be chosen first.
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Figure 3 Exhibition screen

Paul Savage always appears as the Blue Boxer. Notice that Paul has maximum
Speed, Power, Stamina, and Overall Fitness (represented by the green bars).’
Novice players should use him to be more competitive in fights against more
advanced players using weaker boxers. He can also be used against much
weaker opponents to give you a taste of the quick and easy knockout.

Any boxer can be used by one Human against any other boxer, whether
Human or Computer controlled, or by two Human opponents in the same fight
(Paul Savage vs Paul Savage).

If you've selected one-player mode from the Options Menu for the Exhibition
fight, you can only choose a boxer from those available in the gym. The
computer opponent can  be any one of the fifty contenders. If you've selected
two-player mode, both plavers can choose only from the boxers in the gym.



¢ If you'd like to create a new boxer before you enter an Exhibition fight, select
EXIT or press the Escape key to retumn to the Main Menu, and go to THE GYM
{see below). Create your new boxer and retum to EXHIBITION.

If you've decided to have two Computer controlled boxers face off, choose
them from the fifty available. Any Computer boxer can be selected to fight
against another. This can lead to some pretty lopsided victories (The Champ vs
Larry Lunchbucket for instance), but it’s also a good way to look at the
fighting styles of the various opponents before you have to go into the ring
with them.

A Computer vs Computer fight will automatically move from round to round
without any input from you, and while the fight is progressing and you're still
learning, you can get used to switching the cameras during a fight by pressing
¥ | - #0 (on an extended keyboard you can press F1-F10 for the same
result). # 0 (or F10) will always return to the main arena. Press # Y for a
view from your boxer's perspective. Press % U for a view from your

opponent’s perspective.




Figured Arena View

select NEXT or PREVIOUS to cycle through the boxers currently available.
Each boxer appears with his vital statistics and current rank. When the Blue
Boxer you want appears, select DONE. Then choose a Red Boxer, and select
DONE.

Once the boxers are selected you'll need to answer a question before entering
the arena for the pre-fight preparation and nng announcement.

ANSWER A QUESTION, PLEASE

A picture of one of the contenders for the Championship has appeared on the
screen, along with the message “Please go to your *4D Boxing” Manual and
find this boxer’s name.”

. Look through your manual for the face of the boxer on the screen.

2. Type the boxer’s full name, and press Enter.



If vou enter the name wrong 3 times, you will be kicked out of the game to
the desktop.

After a moment you'll see some quick shots of a boxer’s hands being taped,
followed by the walk to the ring, and the ring announcer’s introduction of the
fight and the fighters. When the boxers have moved to their corners, you must
choose whether to fight or look at additional controls (see the CONTROLS section).
Select the boxing glove icon to fight.

EOHTROLS

Figure 5 Box/Controls

BOXING PRACTICE

The first time you enter the ring, spend some time trying out
different fighting techniques and strategies, and refer to BOXING
TIPS AND STRATEGIES below, or try your own.

The best way to practice boxing is to select two-player control
under OPTIONS, then enter the ring and use only one of the




boxers to practice punching, blocking, moving and showboating. Move around
the nng throwing jabs, hooks and uppercuts. Don’t forget to practice the
blocking moves. About the worst thing a boxer can do is to block most of his
opponents punches with his head and body. Keep those gloves up!

BOXING CONTROLS

Punching, showing off, and defense moves depend on the control option you
chose from the Option menu (see Figure 2).

PUNCH (P): OPTION or SHIFT

SHOWOFF (5): ¥ (COMMAND) or RETURN

OPTION and ¥ (COMMAND) control the red (white) boxer
SHIFT and RETURN control the blue (gray) boxer
DEFENSE (D): Press appropriate key

(block/move)

For example, to throw a left hook to head, press 7 on the numeric keypad and
press SHIFT. Or if you selected main keyboard from the Options menu, and
wanted to throw a left hook to head, press "W before pressing OPTION key.

P: Left Hook to Head P- Right Straight to Heod P: Right Hook to Heod

S: High Flurry S: Stick Out Chin 5: Bolo Punch

D: Left High Block D: Move Forward D: Right High Block

P- Left Hook to Body P- Left Jab to Heod P: Right Uppercut to Heod
§: Shake Arms 5: Taunt §: Shuffle

D: Move Left D: Nothing D: Move Right

P: Left Straight to Body | P: Right Straight to Body P- Right Uppercuf to Body
5: Shake Head | 5: High Flurry - §: Low Flurry

D: Left Low Block |

D: Move Backward D: Right Low Block



Alternate showoff moves when opponent is knocked down:

Raise One Arm & Jump Raise Both Arms & Do a Back Flip
Triumphantly Look Up in Jubilation for the Victory
Outstretch and Roise Arms Raise One Arm Raise Both Arms
Do o Back Flip Ouistreich and Raise Arms Roise One Arm

Press RETURN to get up from any knock down.

Special Keys

® P pause/resume

® Q quit the program

+ adjust boxer graphics level up (slower)

adjust boxer graphics level down (faster)

S sound off/on *

C crowd off/on ®

K music offfon *

ESC exit the current screen

~or’ exit a fight to access the Controls

* can be accessed pulling down the Sound menu on color monitors afier
pressing ESC

The Escape key can be used in most areas of the program to exit the current
screen and return to the previous menu.

On extended keyboards, the Function Keys are set to allow
you to easily switch between nine arena cameras after a fight
has begun. F1-F10 will switch the cameras and ¥ Y and

# U switch to a boxer-eye-view. Refer to Using the Cam-
eras under the CONTROLS section for complete information on
adjusting cameras.




DAMAGE, POWER AND OVERALL BOXER CONDITION

Figure 6 Damage, Power, and Condition Indicators

During a fight, the Damage (D) and Power (P) levels of each boxer are
indicated by the Blue and Red bars under the name plaques. The Yellow bars
at the bottom of the screen indicate each boxer’s overall (O) condition for the
fight.

The Damage bar indicates how much damage your fighter has received. The
more damage received, the shorter the bar becomes. Pay attention to this bar
and retreat when necessary to recuperate from the punishment. If you wait too
long, your fighter could go down for the count.

The Power bar reflects how much stamina your fighter has, how many punches_
he throws, and how many punches he is absorbing from his opponent. Power
tends to decrease over time as fights progress into the late rounds. When this
bar becomes short, punches won't be very effective against your opponent, so
retreat until you get vour wind back.

The yellow bar represents the Overall condition of your fighter over the course
of the fight, and is cumulative for the entire fight. It is a good indicator of how
vou are doing relative to your opponent. To maintain your overall condition,
avod being hit, and hit vour opponent as often as you can.

The Fighting Distance Indicator above the boxer name plaques will let you
know when you're within striking distance of vour opponent, and also indi-
cates when you are out of his punching range. Each glove on the indicator
represents one of the boxers, Blue on the left, Red on the right. When the
boxers are close enough to score blows, the area between the gloves will tumm
yellow. Remember not to throw punches and waste precious energy if you
aren’t close enough to score a hit.



To begin fighting, select the Boxing Gloves icon. The bell will sound and
you'll be on your way to your first victory or defeat. Refer back to the BOXING
CONTROLS section if you are unsure how to punch, block or move around the
ring.

BOXING TIPS AND STRATEGIES

There are almost as many winning strategies in boxing as there are boxers.
Each fighter has a unique body and boxing style, and the strategy used in any
one fight will depend on the opponent, the experience of both fighters, the
level or training and preparation, and many other factors. The following tips
are general guidelines,

Study your opponent’s abilities before entering the ring. If he lacks stamina for
~ instance, you may be able to bide your time, wear him down, then take him out
in the later rounds of a fight. If he’s fast, move in to land some punches, but
quickly retreat, or you may find yourself absorbing more punches than you
deliver. Be alert, keep your gloves up, and move around and use the whole
ring. Mix it up.

Boxing's simplest weapon is the jab. It’s a straight punch, thrown from the
shoulder, then snapped back into defensive position. 1t's used to keep an
opponent off balance and at a distance, to “measure” him — that 1s, to get a
feel for how far away he is so that other punches can be thrown and landed
accurately. It's used to set up other punches too, often a straight right hand,
making the basic “1-2” combination. A boxer with a good jab can control any
fight, but many boxers neglect it because it isn't a glamour punch. It doesn’t
produce knockouts.

Strive for accuracy with your jabs. Measure your distance, look
for openings in your opponents defense, and land your punches.
The openings will come, so take advantage of them. If your
opponent goes up top, concentrate on his mid-section. When he
counters, go for the head. Mix it up.
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Many fighters try to “load up” for a single, bout-ending blow. This rarely
works. A good fighter punches in combinations, often working on his
opponent’s body early in the fight to bring down his guard and sap the strength
from his legs. On the other hand, throwing a frantic flurry of punches that
stnike only air will do nothing but tire you out. Flurries have their place, but it’s
best to be more deliberate in your attack, more calculating, but not predictable.
Throw your punches in quick combinations. Left-left-right. Left-right-left.
Left-right. Leftlow-leftmiddle-righthigh. Lefthigh-righthigh-leftlow. Leftlow-
rightlow. Keep your opponents off guard. Mix it up.

Remember that most amateur and professional boxing matches are won on
points awarded by the fight judges. Landing, not just throwing, more punches
than your opponent is the key to victory, Concentrate on landing as high a
percentage of your punches as you can. Check the fight statistics to see how
you're doing. When your adversary blocks high, go low and score.

Defense

Casual observers of boxing see it as two people trying to hit each other. But
remember, a fighter who neglects defense will have a short, painful career.

A good defensive fighter is a perpetual motion machine. He is constantly
moving, not only from side to side and around the ring, but “bobbing and
weaving,” his head to avoid being hit, when he’s within punching distance. He
tries to avoid getting trapped on the ropes or in the cormners. He keeps his
gloves up to protect his head, and his elbows tucked in to protect his body.
When he punches, his blows are quick, sharp and straight. Looping, round-
house punches leave a fighter wide open to a quicker, more effective
counterpunch.

If you start to take a real beating in a fight, step back and shake out the
cobwebs before you go down. If you stand flat-footed and take more punish-
ment, it'll be only a matter of time before you go down. If you get knocked
down, wait until the count reaches eight before you stand up to rejoin the fight.
If you are knocked out, you'll find yourself waking up from a dream world.



Summary

Although every fighter should know the basics of boxing strategy, each boxer
can tailor his strategy to his own strengths. A heavy-handed slugger, for
example, would be wasting his time dancing around the ring, worrying about
his defense and trying to outbox his opponent for a decision win when he can
just wade in, feeling confident that he can knock his opponent down before

getting hurt himself.

THE GYM

When you select THE GYM, you can create up to nine custom boxers that can
be used to fight in Exhibition and Main Event matches.

Figure 7 The Gym

If you select CREATE and The Gym is full, you’ll have to either Delete an
existing boxer or Cancel until later. This Gym can only handle nine boxers at

a time.



DISPLAYING BOXERS

Select NEXT or PREVIOUS to view the boxers currently available from The
Gym. If there are fewer than nine boxers in The Gym, you can create more al
this time.

To create a boxer, select CREATE from within The Gym. The boxer creation
screen will appear and the space where you enter the boxer’s name will be
mghlighted.

Fipure 8 Boxer Creation Screen

To enter a boxer name just start typing. When finished, press Return. Move the
pointer down to adjust the sliders that determine the boxer’s Height and
Weight, the overall balance of Speed, Power and Stamina, and his/her
appearance.

I'he sliders can be adjusted by using the pointer to drag the shder to the left or



right. Notice that the boxer in the gym and the vital statistics in the information
box below him change depending on which direction the sliders move. Look at
the difference in the fighter as you move the sliders all the way to the left and
right, increasing and decreasing the height and weight to the minimum and
maximum settings.

Boxers can range from 570", 135 Ibs (152 cm, 61 kg) for the lightweights, to
6'6", 250 Ibs (198 cm, 113 kg) for the heavyweights. Select any combination
of heights and weights between these limits. Once a weight is selected your
boxer will automatically be placed in the proper weight division; either
lightweight, welterweight, middleweight, light-heavyweight or heavyweight.

Boxers are initially given an equal amount of Speed, Power and Stamina.
These important boxing attributes are represented by the green bars under the

“ boxer’s vital statistics. All three can be adjusted up or down using the sliders
on the right. Notice that as you increase or decrease any one of them, the others
change simultaneously. You must decide on the proper balance for each boxer.

Remember that fights are often won on points for landing more punches, as
opposed to winning by knockouts (KO’s) or technical knockouts (TKO’s). A
faster boxer landing more punches than a stronger opponent will often win by a
decision of the fight judges. For fighting tips, refer to the Boxing Tips and
Strategies section under Exhibition below.

Consider the fighting style you’ll use to control your boxer. If you want to be
aggressive and punishing in the early rounds, give him more power and speed.
If you want him to be better in the later rounds of longer fights, give him
sufficient stamina and power. If you want him to land a lot of punches through-
out a fight and try to win on points, give him more speed and
stamina.

You can create new boxers at any time so feel free to expen-
ment. As you leam to fight and develop your own boxing style,
you can create better boxers for your particular style. When you
go the Main Event and start your boxer’s career, you can train




on the speed bag, the heavy bag and jump rope to improve your overall
condition in all areas.

There are fourteen different heads available for your boxer; 12 male and 2
female. Drag the slider to the desired head. Next select colors for your jersey
and trunks so you can look your best for the crowd.

Finally, decide whether you want your boxer to lead with his left or right fist.
Most boxer’s lead with the left hand to set up the more powerful right-handed
punches, but you may want to try creating some boxers that lead with the nght.
That may give you an advantage over a right-handed fighter. Once the right or
left lead 15 determined, select Done to retum to The Gym.

If you want to build another boxer, select CREATE again.

THE CONTENDERS

Here's a sampling of your competition, given with their rankings, from
weakest to strongest.

50. LARRY LUNCHBUCKET
Began his career with high hopes, but soon leamed he didn’t have what it
takes to become a contender. He’s the classic “opponent,” traveling
anywhere on short notice to fight anyone at any weight. “T don’t go out
there and try to lose, * he says, “but I'm a realist. If I hit a guy with my
best shot and he doesn't even blink, I start looking around for a soft spot
on the canvas.” Reports that he sells advertising on the soles of his boxing
shoes are unfounded.

46. ENOS “DON” MATTRELLI
A former circus strongman, this big fellow is rumored to be managed by
some unsavory characters. He denies the rumors, and one has to believe
him considering he keeps losing fights.

45. LANCE “SQUISHER"” BOIL
Tall youngster with good speed but little power. Whispering about his
poor work habits persists, especially since he seems to wear down quickly
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under a body attack. “It's true, I could spend more time in the gym,"” he
says. I think I'm going to do that. Yeah, starting tomormow.”

FLAPPER HOLLYWOOD

Here's a guy who looks like a fighter. Before the bell rings, that is.
Hollywood has appeared in several TV shows as, of course, a boxer.
Unfortunately, in his real fights, he doesn’t have a stunt double.

CAPTAIN KIDD

He's fast, he’s flashy, and the crowds love his showboating style. His
opponents love him too, because he sells tickets, but he can’t fight very
well. The Captain picked up his nickname, and his crowd-pleasing style,
during his days on the waterfront, when he participated in tough-guy
COontests.

WILBUR GNASH

“The Rambler” owes his reputation to a shocking upset of No. | contender
Mean Mutha Mormison early in his career, The quick southpaw has been
on the fade ever since, but he can stll be dangerous if an opponent takes
him lightly. He's a boxer-puncher with no real weaknesses.

ANAGRAM UNBLICLNA

Here's a guy who doesn’t know the meaning of the words “backward
step.” Come to think of it, he doesn’t know the meaning of the word “cat,”
but what does that matter? Unbliclna is aggressive to a fault. True to his
name, Anagram likes to mix it up.

SLIPPY MAD FROG

A nature lover who used to work on his hand speed by catching flies with
his fists. It didn’t really help. Him or the flies. “It did save me money on
no-pest strips, though”, he says. The Mad one has good punching power,
but he isn't afraid to box, and he’ll use the entire ring. “It’s my lily-pad,
baby, and I like to visit every part of it.”

WILMA HEADHURT

Thas lefty is out to prove that a woman can find a place in the man’s world
of the squared circle. She’s a talented boxer with good speed, but she’s
been criticized as a “safety-first” boxer ever since she “got her bell rung”
in a tough fight a few years ago. “Yes,” she says. “Hello? Who's calling?
Did you hear the phone?”
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FLUSH GORGON

The “Punching Plumber™ has a loyal following and he rarely disappoints
them. He has good speed and he’s tough to knock out. “I spend plenty of
time on my back in people’s bathrooms.” he says. “ [ like to stay on my
feet in the ring”

SADIE MAZO-CHISHOLM

“I like pain,” says Mazo-Chisholm. 1 like to take it and I like to dish it
out.” She certainly picked the right business. Tough and hard-punching,
willing to take a punch or five to give one, Sadie has risen to fringe
contender status. Fight crowds love a brawler, and Sadie is their lady.

IVAN ORRIBLE ATTITUDE

If nastiness alone won fights, this guy would be undefeated. As it is, he’s
pretty close. Very fast and very busy, he overwhelms opponents with the
sheer volume of punches thrown. His one regret is that he doesn’t have
more punching power to end fights quickly. “[ don’t believe in long
fights,” he says. “1 hate going back to my corner at the end of a round. My
trainer has terrible breath.”

SUGAR JAY MACK

Sweetl as sugar outside the ring, mean as a Mack truck in it. This third-
ranked contender is known for boring in on his opponents during his
fights, and boring the world with his saccharine comments afterward.

CRUNCH TAYLOR

Dirt-poor as a kid, Taylor couldn’t afford bus fare to the gym, so he began
training in his own backyard, using his brother as a heavy bag and his dog,
“Stretch”™ as a jump rope. He still trains out back, but things have changed.
His ring success has brought the wealth to allow his brother to retire, and
Taylor hires kids from the neighborhood to act as heavy bags.

THE CHAMP

Bom Irving Milquetoast Thistlewaite, this fighting machine had his name
legally changed to The Champ when he won the title. Famous for such
charming statements as “1 love to see a man twitching on the canvas,” and
“I"'m sure someday | can push my fist straight out the back of an
opponent’s head,” The champ figures to be on top for yvears to come.
Unless someone can come along and pull off an upset!



DELETING BOXERS

If, after viewing the boxers, you decide it's ime to bring in some new blood,
select the boxer or boxers you want to retire from The Gym, and select
DELETE. Any boxer can be removed from The Gym at any time. When you
select a boxer for deletion, you'll have one opportunity to change your mind
before he 15 lost. The name of a deleted fighter can be re-used, unless the name
appears in the Hall of Fame. If you want 1o use a name that appears there, the
Hall of Fame list must be cleared first.

EXPORTING BOXERS

You can save a boxer to a floppy disk for storage. Simply follow the on-screen
instructions. But vou can only save ONE boxer per disk. If you save a boxer on
a disk that already contains a boxer, he will be overwritten.

IMPORTING BOXERS

If the gym is not full, this option lets you restore a previously saved (EX-
PORTED) boxer. If the boxer you want to import is in the Hall of Fame, vou
must clear the Hall of Fame before importing the boxer. If the gym is full, you
must delete a boxer before trying to import a new one.

THE HALL OF FAME

The Boxing Hall of Fame is a cherished place. Your goal is to have your
boxers’ names appear here, especially at the top of the list. If you dedicate
yourself to the task, your dreams of boxing glory can come true.



Figure 9 Hall of Fame

The Hall of Fame list can be erased at any time by selecting Clear from within
the Hall.

THE MAIN EVENT

This is where your boxers begin their professional careers. You'll try 10
manage them all the way to the Championship and the Hall of Fame. Main
Event victories and defeats go on your permanent career record, so winning 1s
critical. Winners also take home more cash, so be sure to choose your oppo-

nents carefully.

When a boxer from your gym first embarks on a professional career he will be
ranked 51st in the world. and his record will show all zeros; no wins, losses,




decisions, knockouts, or prize money. It should be your goal to build up your
victories and prize money, thereby improving your world rank. If your fighter
siarts out a career with several losing performances, it might be a good idea to
consider an-early retirement. Just go back to THE GYM and remove him.

When you have decided which of the boxers from your gym you want to fight
in a Main Event bout, select DONE or press Return. The Challenge Board will
display the names of several contenders.

Figure 10 Challenge Board

All ehigible opponents are denoted with an asterisk to the left of the boxer's
name. In the lower rankings it is possible to skip over several ranked fighters,
allowing vou to move quickly up the list if you are victorious. As you move up
though, you'll have to fight through more opponents. Make it to the top ten and
you'll have to fight just about everyone. These guys aren’t in the top ten for
nothing, They attack. They re vicious. Good luck.



£ It's possible 1o spar with any of the 50 Computer controlled opponents prior to
: challenging them in the Main Event. Consider taking them on in Exhibition first.
You have nothing to lose, except a fight.

To challenge an available opponent to a Main Event fight, use the
pointer to highlight your selection, then click on the challenge icon.
Then you’ll proceed directly with your training.

BOXER TRAINING

Nobody is in better physical condition than a properly trained fighter, and that
takes work and dedication. Running and rope jumping build leg muscles and
stamina. Hitting punching bags of various sizes and proportions helps a fighter
build strength, quickness and accuracy. Calisthenics build up the muscles in
the torso and neck that help a fighter absorb punches. Sparming lets a fighter
work on his timing, his defense and his ability to put into practice the strategies
he has been taught by his trainer.
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Figure 11 Training



Before each Main Event fight your boxer will have the opportunity to train and
improve his Speed, Power and Stamina. Once you select an opponent you will
be able to work on the speed bag to improve his glove speed, pound on the
heavy bag to build up his power, and skip rope to improve his stamina. You
can determine how much work you do in each area by varying the time you
spend on each training exercise. The red areas extending from the green Speed,
Power and Stamina bars indicate the amount of improvement possible for each
during the training session. Use the sliders to adjust your training, then proceed
to the fight.

SCORING

In 4D Boxing, the judges use the common 10 Point-Must-System to score each
fight. This means that each judge must give 10 points per round to the boxer he
judges to be the best for that round. The other boxer is usually given 9 or 8
points per round depending on the quality of his defense. Lower numbers are
sometimes awarded for particularly poor performances, but not often.

In most fights the outcome is clear and one fighter wins by Unanimous
Decision, or in some cases, by knockout. Occasionally however, the fight is so
close that the judges can score a split decision. That is, at least one judge out of
three declares the losing fighter the victor on points, though the other two
judges declare the winner. Decisions will be announced immediately after each
tight.

Boxers knocked down can be saved by the bell. That is, a boxer who is
knocked down with less than ten seconds left in the round cannot be counted
out of the fight by the referee. He can return to action after the break.

The three knockdown rule is in effect at all times. This means if you are
knocked down three times in a round, the fight is ended and the match is
counted as a loss.

The fight referee is invisible, but he is watching you! If you are able to knock
your opponent to the canvas, move immediately in the direction of a corer. If
you don’t move away from the downed fighter, you'll be given a warning by
the referee. If after the wamming you don’t immediately move in the direction of
a corner, points will be deducted from your score by the judges and next you'll
be disqualified for unsportsmanlike conduct. Be sure to move away from a



downed boxer immediately or your career record may be black-marked by a
disqualification.

If it"s you that happens to end up on the canvas, wait for the count to reach
eight before you get up. This will give you the most time to recover. To get up,
press Return. After you get up, shake out the cobwebs.

BOXER RETIREMENT

You'll have forty-five opportunities to fight your way through the fifty
opponents in your weight division to reach the pinnacle of fighting success,
The Championship. After thirty-five fights your boxer will begin to tire. If
after forty fights he hasn’t reached the top of the rankings and become Cham-
pion, he will be given five additional chances, although one additional loss will
force his retirement. After retirement, he will no longer be available to fight in
any boxing event, so you'll have to create a new contender.



CONTROLS

Select the Controls button before a fight or press the Escape key after a fight
has begun to access the Master Panel.

Figure 12 Master Control Panel

From the Master Panel you can reposition the arena cameras, switch from
stationary to motion cameras, change the point-of-view from the cameras to
that of one of the boxers, view the video replay from any angle and at numer-
ous speeds, view the fight statistics, throw in the towel to end a fight, or adjust
the graphics/animation level.

Following are descriptions of the Master Panel icons, starting from the left.
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THROWING IN THE TOWEL | i

If you decide you are overmatched in a fight, you can throw in the towel to end
it. Remember that if you do this during a Main Event fight it will be counted as
a TKO loss on your record, so be sure to carefully consider which opponent 1o
choose before entering the Main Event. If you throw in the towel before the
opening bell of the planned event, it will not be counted as a loss and you can
then choose a different opponent or return to the Main Menu.

Il
USING THE CAMERAS

All of the original default cameras are on stationary tripods and are controlled
by cameramen, but each can be adjusted for more diverse fight viewing. In
addition to 3 1- % 0, Function Keys F1 through F10 can be used during
fights to switch cameras (% Y and # U switch to the point-of-view of the
boxers). The camera views can also be selected by pulling down the Camera
menu on color monitors.

If you want to switch or reposition a camera, change from stationary to mobile
cameras, remove the cameramen, add a crowd background to a stationary
view, or view all of the camera positions at the same time, select the camera
icon from the Master Panel. The View Options panel will appear.
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Figure 13 View Options

From the View Options panel you can cycle through the nine
cameras with the Plus or Minus buttons, or by using % 1- 3 0.

By selecting the Tripod Camera icon, you can change a stationary
camera to a mobile one; the icon will then appear as a Flying
Camera.




e When selected, the Flying Camera icon will switch back to the
|ﬁ Tripod Camera again. In this way you can easily change between
the stationary and mobile setting for each camera.

The Cameramen icon can either be selected to control all of the
. cameras, or turned off. In other words, it isn’t possible to have
' Cameramen on just a few cameras; either all of them or none
(excluding the main arena Camera set to % ().

Stationary cameras with cameramen will follow the action as it moves from
left to right in the ring, and will zoom in and out to give the best view of the
action. Stationary cameras with no cameraman will not move at all.

Mobile cameras with cameramen will follow the action by moving completely
around the ring, depending on where the fighters move in the ring, and will
zoom in and out as necessary. This provides the widest variety of views for all
fights, with the least amount of input required of you as you box.

If, while viewing a fight through a stationary or mobile camera with no
cameraman, the boxers begin to leave the viewing window, press the space bar
to re-center the camera on the action. By holding the space bar down, the
camera will track in a smooth and continuous motion. In this way you become
the cameraman.

To view all the camera positions at the same time, select the
Control icon to enter the Camera Control Room.
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Figure 14 Camera Control Room

The Plus/Minus buitons and % 1- 3 0 will now move a box o
highlight the different views. To switch back to one view, select
Master from the panel.

When you find a view you'd like to change, select Adjust to access
the Position Camera panel.



Figure 15 Position Camera

Eight of the cameras can be adjusted and saved for future use from the Position
Camera panel (excludes the main arena camera set to 30, the upper left
camera within the Camera Control Room). Only one set of cameras can be
saved. If you reposition only a few, the rest will remain in their default
pOsILIONS

Select the camera you'd like to move, then press and hold down the

camera movement icon with the mouse button. Now the number
kevs on the numeric keypad can be used to raise or lower the

camera, rotate it left or nght around the ring, or move it closer or
further from the ring.
While making the adjustments, 1t will appear that the ring itself 15 moving,
while in fact the camera 1s being moved. Use the following keys on the
numernic keypad to adjust the cameras:



Move Camera Up Move Camera Closer Move Camera Up

@ ® @

Rotate Camera Left Rotate Camera Right
@ ®

Move Camera Down Move Camera Back Move Camera Down
@ @ @

Once a camera is in position, you can determine whether it tracks one or both
boxers during a fight. This feature can be used to more closely evaluate an
opponent's boxing style using the Video Replay feature. It is far less effective
if used while fighting. ;

Next adjust the zoom lens on the camera in or out. The zoom feature on mobile
cameras will begin where you set it and will zoom in and out depending on the
movements of the boxers.

E; To save the positions of the newly adjusted cameras, select the Disk
- Access button.

Each time you start a Boxing session, your saved camera positions will be
used. The original, default positions will always be available by selecting Disk
Access from the Master Control panel, then selecting Reset. To reload your
saved cameras, select Load.

Remember, the Cameramen will always be turned on for all cameras when you
start a playing session.

VIDEO REPLAY i+

You must replay a round prior to the start of the next one, or it will be erased.
Only one round at a time can be stored for replay, but it can be replayed
repeatedly, and from many different angles and points-of-view. In fact, the
fight can be replayed from camera angles that didn’t exist when the fight was
started. Simply adjust the cameras and the camera settings prior to the replay.
During the replay, % 1-% 0 can be used to swiich the cameras or ¥ Y and
3% U can be used to change the point-of-view.



Select Video Replay to view the fighting action for the current round, or for the
round just ended. The current round can be stopped and reviewed any time
after it's begun, so it's possible to review any completed part of a round before
proceeding with the rest of it. This feature can be used to your advantage by
allowing you to review and make necessary adjustments to your stralegy
during a round, rather than after a round has ended. This can help you score
better or avoid additional damage during the rest of the round.

You can also use the replay feature to prepare for fights just as real boxers do.
Match up your planned Computer opponent with any other Computer opponent
and start them in an exhibition fight of any length. You can then replay each
round, and study the styles of the two boxers to help you plan the strategy for
your upcoming fight.

SWITCHING THE POINT-OF-VIEW

Select this if you want to switch to the point-of-view of either of the boxers, or
if you want to switch from a boxer’s point-of-view back to the cameras. Boxer
point-of-view can also be selected during a fight by pressing ¥ Y3 U,
depending on whose eyes you want to look through.

This is a good way to look at your opponent up close as you deliver your
punishment. Switch to this view if you get your opponent on the ropes and are
about to go for the knockout. You can really tell when he’s about to go down.
It’s also a rather interesting view if you get knocked down.

ADJUSTING THE GRAPHICS AND ANIMATION LEVEL [k

By adjusting the boxer graphic detail down, making the viewing window
smaller, or by using a combination of both options, the speed of the boxing
action will increase. Selecting SimLow under OPTIONS will also help
improve the overall game speed (see OPTIONS above). These options can also be
accessed by pulling down the Render menu on color monitors.

There are seven levels of graphic detail for the boxers, and four sizes of
viewing windows available. To adjust the graphic detail or the window size,
select the Graphics and Animation icon from the Master Control Panel. To



make adjustments, highlight and press a Graphic Level button or a Viewing
Window button and press it until you get the desired level or window size, The
Viewing Window cannot be adjusted if you are viewing a fight from the main
arena camera (38 0). When finished, select Done or press Esc.

Selecting AUTO lets the program set the most appropriate boxer detail level,
depending on the amount of action occurring in the ring at any time and the
speed of the machine. If AUTO is set, the detail level will also be affected
when replaying rounds. If you want the boxer graphic detail to remain con-
stant, be sure AUTO is tumed off.

VIEWING THE FIGHT STATISTICS =1}

Statistics for each boxer in the current fight are automatically displayed at the
end of each round. Information is included for the current round and also for
the entire fight up to that point.



Figure 16 End of Round

If you want to study the fight statistics before a round ends, press Esc 1o access
the Controls and the Master Panel, then select the Stats wcon to display them.
When you are finished, press a key or a button and select Done to resume the
fight where you left off.

SAVING /LOADING /RESETTING CAMERAS |

Select the Disk Access icon if you would like to Load previously saved
cameras, or Reset the cameras to the original positions. This icon also appears
under Cameras to allow you to Save vour new camera settings. The Save and
Load options can also be accessed by pulling down the File menu on color
monors.,



TECHNICAL SUPPORT

If you are still having problems with installing or playing your game, please do
not hesitate to contact our Technical Support Department. They can help. If
your question is not urgent, please write to us at:

Electronic Arts Technical Support
P.O. Box 7578
San Mateo, CA 94403-7578

Please be sure to include the following information in your letter:

Product name
Maodel of computer you own.

Any additional system information (like amount of RAM, video card,
printer, modem etc. )

Version of operating system

Description of the problem you're having

If you need to talk to someone immediately, call us at (415) 572-ARTS
Monday though Friday between 8:30 am and 4:30 pm, Pacific Time. Please
have the above information ready when you call. This will help us answer your
guestion in the shortest possible time.
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